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Using PageMaker

You will be expected to become reasonably adept at using PageMaker, the school’s desktop publish
program. The following is McTutor, designed both to help you get through the initial stages of
laying out a page and also to provide some information that is at the “intermediate level.” It will be
available on the MAC computers in the computer room. Try to follow these steps as carefully as
you can. Don’t be afraid to ask for help. Try to do this on your own. You will be able to learn the
program well if you keep at it. There is a lot of trial and error involved in laying out a page. It can
be like fitting pieces into a jigsaw puzzle. No matter how frustrating it is, when you succeed you
can see what you have accomplished, and this can be very satisfying.

Note: You should save several times along the way. If you think things are going poorly you can
always return to a previously saved document by simply choosing “No” when you are asked if you
want to save the document you are closing, or by renaming the document and returning to the
original to see if it is better.

• To start working on a new document once program opens choose File|New and in the
resulting dialog box set the Page size (11 by 14)

• Orientation (Vertical),
• Start Page number  (1),
• # of Pages (4)
• Options (double sided)
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Once this step is complete, a page is displayed on the desktop. (If the Tools window (left)
is not visible, choose Window|Show Tools. Choosing Window|Hide Tools will hide the
window.).

You are on page one of the document. To move to another page in the document, you click
on the new page number in the graphic index in the bottom left corner of the page. The first pages
you should work on are the “Master pages.”

• To work on the master page, click on the master page icon in the graphic index. "Master
Pages" are located in to the left of the page number but are marked with "L/R." Anything
that appears on the master page will appear on every page of you document. For this
reason, avoid getting carried away. (If later on you do not want a certain page of your
document to display items in the master page, open the Master Page window using the
Window|Show Master Page menu item. Move to the desired page and click on [None] in
the Master Page window. This can be useful, especially for the first page, which is apt to
have a different look.)

• Generally, it is good to have a line running about an inch below the top of the page. To
draw a single straight line, use either one of the tools. Click at the start of the line and
drag to the end of the line. The second tool draws either a vertical or horizontal line.

• If the line is to appear on all pages, you should draw it on both the left hand and right
hands pages.

• On The Portledge Press there has been a fairly elaborate frame at the top of each page
onto which the section of the paper (News, Sports etc.) has been superimposed. These
frames are on the master pages. They started with a line.

• There is presently one column on the page. To change the number of columns, choose
Layout|Column Guides, and enter the relevant number into the resulting dialog box. The
Portledge Press generally has four columns separated by blue lines that do not appear in
print. (The space the lines occupy is called a gutter, which we do not adjust.)

• You might rather leave the Master page with one column and apply the columns guides to
the document pages. This makes a good deal of sense if you are planning to have pages in
which there are two sets of columns. If you switch the number of columns on the page it
will not change anything you have laid out.

• To have the page number automatically on each page, use the tool, click at the desired
vertical location of the page number, and hold the option and command keys down and
type the letter 'P'. The code for the page number, ‘LM’ (on the left page), 'RM,' on the
right will appear.

You should save several times along the way
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View Menu

Move to page one of the document to install text.

• To type in text, click the text tool from the Tools box that is marked by a "T".
• Click the location on the page where you want the text to be. The text will line up

with the left hand edge of the column, and may appear as a gray bar. This is
because the page you are looking at has been shrunk to fit in the Window (screen).

• Type something – this sentence for
instance. You will notice you cannot
read it and that it appears to be a gray
bar. That is because you opened to Fit
in Window (see view menu) Viewing
text as gray bars can be useful in

evaluating page composition.)
• To view the actual size of the text, choose

Actual Size in view menu or whatever
magnification is desired. To zoom in to a
section of the page, choose Zoom to or the
magnifying glass in the tool box. Click on the
desired area or click and drag to enclose the
desired you want to zoom in. To zoom out, choose Zoom out.

• Use pointer tool and click the text. Look for handles at the top and bottom. These are the
beginning and end of your text block (more on this below.)

Generally speaking we do not type directly into PageMaker except when we are adding captions to
photos or creating headlines. Instead we import text that has already been written. This can either
be done by placing it directly or by cutting and pasting it from a word processor file. You should
have a number of such files in your folder on the Mac. The can be imported directly if we have the
appropriate filter. (For example, we have a filter for Word 97 (IBM) files, but not for Word 98
(Mac) files.

Placing Text directly:

• To make sure that text flows continuously from one page to the next, and that additional
pages are created automatically, choose Layout|Autoflow. This menu item will now be
checked, and text will flow automatically. To flow text manually, choose
Layout|Autoflow once again. I prefer manual, but Autoflow is easier at first.

• To place text (i.e. a Word file) into a document, make sure you are using the pointer tool
from the toolbox.
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• Choose Place from the file menu.
• Locate and select the file you want and click open.
• To place the text, click the cursor at the point where the text is to begin. The text is fitted

to the width of the column, and whatever length is necessary.

Copy and pasting text:

• Open an existing file. You may have to open a program (Word or Appleworks) to do this.
There is no problem having more than one program open so do not close a program until
you have finished copying and pasting all the articles.

• Select All and copy.
• Return to the PageMaker program. (Moving from one program to another is done by

clicking on the appropriate program at the top right of the screen.
• Paste it where you want the text to appear. Make sure the arrow key and not the text key

from the toll bar has been selected.

Applying a uniform style. No matter what format the original text is in, and no matter how it is
imported, the first thing you should do with any article is insure that it has the same appearance in
terms of type style as any other article. To do this, you must determine what that style should be.
To do this:

• Choose Define Styles from the Type menu.

• 
• 

• Click body test from the menu on the right and click Edit.
• Click Character to change font, size, or type style. Generally, Times or Times New

Roman 10, Normal (Plain text) is suitable for the paper.
• Click Paragraph to change indents. This may or may not be appropriate. If the original

articles have no paragraph indents, you should click indent first paragraph and decide the
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appropriate size; if they have indents, however, this will give them a double indent.
Recent editors have made original copy have no paragraph indents so that they can
control the size of the indent through the style menu.

• Also on paragraph click justified for alignment.
• Click OK after finishing these changes. Then highlight the text of you article(s) and click

body text in the Styles (not define styles) menu.

You should save several times along the way

At this point the text in your text blocks will be standardized and you will be able to see how much
space each article occupies on the page,

• Use the Pointer tool and click the text. Look for handles at the top and bottom. Again,
these are the beginning and end of your text block.

• To move a text block click in the middle and drag it. You will be able to place it
anywhere on the page including on top of another article.

• When you select a text block, there may be symbols in the handles:
• Red Triangle: the text block is too small for the text. You can either make the text block

larger or have the text continue to another block.
• Plus Sign: what is written in the text block extends to another text block. This probably

has not happened unless you have moved an article that was one column into two or you
had used autoflow with a long article.

• To move an article from one column into two click on the red arrow at the bottom of the
text block. An icon looking like a box with text in it will appear. Drag it into the next
column and click. The rest of the article will appear. The plus sign will be at the top. You
can manipulate the balance between the length of the text blocks in both columns by
dragging the plus sign. This enables you two have a two-column article with each column
and equal length.

See “fine tuning” at the end of the tutorial for suggestions about adjusting body text to fit the space
available.

You will need to create headlines or change the size of the headline that the original article
provides. Before doing this, you should:

• Click Headline in the define styles menu and click Edit. (if there is no “Headline” click
“New”)

• Click Character to change font, size, or type style. Generally, we have used Palatino 24
or 18, Bold

• Click Paragraph to change alignment to centered.
• Click OK after finishing these changes.

You might more than one headline style (a smaller size; ALL CAPS; Italics etc.). To create a new
style:
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• Click New in the define styles menu.
• When you have defined this style, label it appropriately (for example, headline 2).

Generally speaking, it is best to have headlines in a separate text box. It is necessary to
do so if you have a two-column article. You can stretch a text box over two columns by dragging
on of its side handles. To separate an already existing headline, cut it from its article and past it in a
new text box. (Note, the danger of separating headlines from articles is placing a headline on the
wrong article – make sure this does not happen!)

See “fine tuning” at the end of the tutorial for suggestions about adjusting headlines to fit
the space available.

Next, you should standardize the text of the by-line. After deciding how you want the by-
lines to look follow the same procedure as you have for body text and headlines. Then highlight the
bylines at the top of each article and click the style by-line. (At this time it would be advisable to
see that all the “by’s” are capitalized.)

Finally, you should standardize the text for captions (idents), even though you probable
have none. Press captions are usually centered, usually on pica1 less that the body text, and usually
italicized. After deciding how you want the captions to look follow the same procedure as you have
for body text, headlines, and by-lines.

You should save several times along the way

With the text in place, it's a good idea to load up all the graphics (shortcut Ctrl + D) onto the
surrounding pasteboard. This is important as we need to know roughly the amount of space they are
going to require. Generally speaking, we are short on photographs. We hope to remedy this
situation this year with the use of a digital camera. In addition to photographs, relevant charts can
accompany an article, and a long article can be broken up with sub-headlines taken from the text.
Although we have access to clip art, most of it is filler at best.

In terms of positioning and sizing the graphics, a number of factors come into play.
Obviously the pictures have to be positioned next to their relevant text, but it's important to try to
disperse them in a balanced way. One of the problems we have had in the past is that most of our
pictures are physically pasted onto the proof copy sent to the printer. It is possible to adjust the size
of these pictures, but they are usually cropped to fit in a box we have placed in the text. Also,
remember that the picture should not overwhelm the article. If it does, it makes more sense to use
the article as a caption. In any case, when laying out for graphics, leave space for captions. See the
photojournalism tips at the end of this chapter to get an idea what kind of photograph works best. If
you are lucky, you will end up with a layout where all the text and graphics are seamlessly
combined and look like they belong together. But be happy if you can get them all to fit on the
page!

                                                                        
1 A pica is a printer’s unit of measurement equal to 12 points,
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Placing a graphic:

• Go to the Entire pasteboard option in your
View menu.

• Make sure Text wrap is on. ((Alt + Ctrl + E).)
• Choose Place from the File menu.
• Locate and select the image file.
• Click Open. You can move the image to an

appropriate place on the pasteboard or on the
page in the same way you moved text blocks.

• It is also possible to copy and paste images
into PageMaker. (This works in a manner
similar to cutting and pasting text.)

You should save several times along the way

Like text, images can be sized. With all the graphics on the pasteboard and all the text on the page,
you should have a general idea if everything will fit. Chances are you will want to resize a graphic
even before you move it where it belongs.

Sizing a graphic:

• Select the image using the pointer tool.
• Hold Shift and click one of the handles of the image.
• Drag the handle until image is in the correct place and release the mouse.
• Or, using the Control Palette, select the image.
• Enter the exact percentages or measurements and press enter.

Cropping an image is similar:

• Select the image.
• Select the cropping tool from the toolbox.
• Click and drag a handle of the image until the desired size.
• Cropping the image does not delete the part that is not viewable. To regain

the whole image, repeat steps above dragging the handle outward.

Because you have turned text wrap on, you should not have to use the Arranging Elements menu.
However, see Arranging Elements under Fine Tuning below in relation to boxing articles or
graphics.
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If you do not have text wrap on, you can have it on by completing
the following steps:
• Select an image.
• Choose Text Wrap from the Element menu.
• Select the wrap option and text flow option indicated and

click ok. You will see a dotted boarder with diamond
handles around the image. No text can come closer to that
image than the dotted lines.

• Size the dotted border that is around the image by clicking
and dragging the handles or changing the numbers that
indicate the boarder’s size. Generally speaking the borders
are too large, especially the bottom border.

• Click and drag a text block over the image and size it.

Once you have place a graphic next to an article or a caption under a
graphic you might want to keep them in the same relationship even
if you move them somewhere else on the page or onto another page
entirely. To do this you need to “group” the element you want to
stay together. To group elements:

• Hold shift and select all the objects
you want to group.

• Choose Group from the Element
menu.

• To ungroup elements, select a group
and choose Ungroup from the
Element menu.

As noted at the beginning of the tutorial there will be a lot of trial
and error as you attempt to coordinate text and graphics and
headlines. Even when you manage to get everything you want on the
page where you want it to be, you might still need to do a number of
things to get the page to “look right”

You should save several times along the way

Element



111000:::   DDDeeesssiiigggnnn   aaannnddd   DDDeeessskkktttoooppp   PPPuuubbbllliiissshhhiiinnnggg

{PAGE  }

Edit Menu

Fine Tuning.

Nothing improves the overall look of the page more than the judicious use of lines and boxes. Our
last two layout editors were line fanatics. To get an idea why, look at the New York Times. Almost
every article has a line or a double line separating it from other articles. Articles and graphics are
also boxed. The overall effect of this is a crisp look.

• To make a solid box, click the Rectangular shaped button located on the Toolbox.
Click and drag to desired size.  Resize by clicking and holding on corners/sides.

• There are also times when you will want to box an article or a blank space for a picture
that will be pasted on to the final proof.

• When you make a box over an article the article will disappear unless text wrap is on.
In any case you will want text wrap off because you are layering not wrapping. To see
the text beneath a box Select the box and go to Arrange in the Element menu (see
above).

•  Click on send to back.

This can get tricky with text wrapped photos. Ask for help if things seem to be going wrong.

• If your headlines don’t fit, you can resize them, make them “tight” or “very tight” using
the tracking option in the text menu, or you can always reword them.

Although you do not want to resize the text in articles, you can also make them take less space by
“tight” or “very tight using the tracking option in the test menu. You can increase or decrease the
leading by changing the leading (the space between lines - also in text menu). Finally you can edit
the article. To do this it is best not to do so directly on the page, especially if the text requires lots
of editing.

Instead you should use the edit story menu. This also gives you access 
to the Spell check. To edit text:

• Select your text by clicking on it and then choose Edit Story from
the Edit menu. This works like any word editing software.

• You can use spell-check by choosing Spelling from the Utilities
menu. Note you can spell check all the articles in your paper at
once. Most misspellings occur in captions and headlines because
they are often added after spell-check has been run.
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Don’t pad articles. If copy seems short on a page that's not a problem at all as it allows you to add
white space around headings and images.

To make sure elements are precisely aligned it is good to use guides. This is especially important if
you have side-by-side photographs or headlines.

• To add a guide, click and hold a ruler and drag it onto the document.
• Align the guide to the place you want it and release the mouse button.

PageMaker is a reasonably complex program. The above is only an introduction to it, but should
provide a good grounding in what you need to know to layout page on a paper.

REVIEW

Design:

Where is the traditional place on page 1 for a
lead story?

What can you do to give a paper a distinct
“look.”

Why is it desirable to run an article on one
page when possible?

Headlines

What is the historical present tense?

Where are you most likely to find one-word
headlines?

What is the ideal length for a traditional
headline?

What is the purpose of sub-headlines?

PageMaker

Explain the following (they all appear on
diagram on page 82)

Handles

Text blocks

Graphic object

The dotted lines with diamonds that surround
that graphic object.

Justified text

The tool box

Master pages

The control panel

A plus sign in a handle

A red arrow in a handle.


